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1.	Edit View
1. 1.  Drawing Paths

Create paths with the Draw or Form tools.
When the Draw tool  is active, click to create straight lines, 
or click and drag to create curves. Move the curve point by 
holding down the space bar.
All curve segments are connected smoothly, which is 
indicated by a green circle. In order to convert curve points 
into corner points, hold down the Option key while dragging. 
A blue circle indicates corner points. 

1. 2.  Editing Paths
Click and drag to select nodes and handles inside a rect; hold 
down the Shift key to extend or reduce the selection. Note 
that unlike in most editors, you can select multiple handles 
independently of the nodes.
Move the selection using the mouse or the cursor keys. This 
also works if more than one handle is selected.
Moving nodes will move the attached handles even if they 
are not selected. Hold down the Option key to move only 
explicitly selected points.
When moving a handle while holding down the Option key, 
its angle remains unchanged.
Convert between smooth connection and corners by double 
clicking or selecting the node and pressing “Enter”.
The attributes of the selection are shown in the grey info 
box.

When more than one node is selected you can alter or move 
the selection by changing the numbers the info box. Set the 
origin of the transformation in the field of reference points.
Option-clicking a line segment converts it into a curve.
To convert a curve into a line segment, select and delete one 
or both handles.



1. 3.  Opening Paths and Corners
In order to segment a closed path, select two nodes and select 
“Reconnect Nodes” in the context menu. To open the context 
menu right click or Ctrl-click.
If one node is selected, the option “Open Corner” becomes 
available, which works in a similar fashion.

1. 4.  Alignment Zones

Nodes located exactly on a vertical metric line (see also Font 
Info) are highlighted with a brown diamond. Located inside 
the alignment zones (see also Font Info) the highlighting is 
shaped circular. This allows for controlling the position of 
nodes even in small zoom scales.

1. 5.  Fit Curves

The Fit Curve panel helps creating curves with matching 
curvature. In most instances the one line view is enough. 
For finer tuning click the little triangle to widen view.
Click arrays to alter the curvature of the selected curve 
segments. When the curvature is adjusted, click the same 
array to adjust other curve segments (e.g. in other letters 
of the same font) accordingly. This way you get matching 
curvature in different curves.
Select percentages as desired by setting the left array to the 
minimum value and the right array to the maximum value. 

Tip: In all number input 
fields in the whole 

application, you can use 
the up and down cursor 

keys. The Shift key 
increases the value be 10.



The arrays in between interpolate between the two values. 
The numbers describe the percentage length of the handle, 
when the distance from curve point to the intersection of 
the handles equals 100%.
Values between 50% and 80% stood the test, 57% 
approximately correlate with a circle.

1. 6.  Filters
Glyphs has an expandable plug-in interface. The plug-ins can 
contain filters, tools, panels and file formats.
You can apply filters to the active layer in the edit view, 
several selected layers (with the text tool) or in the font 
view.
The following filters come with Glyphs:

1. 6. 1.  Hatching
Creates hatched letters. Distance, width and angle of the 
hatching lines can be chosen. Glyphs always uses the 
background path. When there is no path in the background, 
a copy of the current path is saved in the background. Alter 
the appearance of the hatching by changing the background 
path and applying the filter once again.

1. 6. 2.  Offset Curve
Changes the thickness of stems horizontally and/or 
vertically.

1. 6. 3.  Remove Overlap
Choose “Remove Overlap” to remove overlaps of all selected 
paths.

1. 6. 4.  Round Corners
Apply this in order to round all selected corners. To only 
round the outside corners simply select nothing. Apply 
“Visual Corrections” to adjust the radius of different corner 
angles and create a more consistent appearance. 

1. 6. 5.  Transformations
Apply “Transformation” to horizontally and vertically move, 
scale and tilt glyphs. Fix the origin when scaling and tilting. 
Tilt without or with optical correction by choosing “Slant” 
or “Cursify”. Optical correction requires correctly set vertical 
and horizontal stems (see also Font Info > Master).



1. 6. 6.  Background
Use “Background” to interpolate between front and 
background paths. The paths need to be compatible.

1. 6. 7.  Metric
Use “Metric” to set the width of a letter and the absolute or 
relative side bearing.

1. 7.  Anchor and clouds
Characters built out of components are handled in a special 
way. 
Accented or marked letters, built from a base letter and a 
mark, automatically inherit the spacing from the base glyph. 
The mark is positioned according to the anchor positions. 
The accented letters are always in sync with the base letter, 
even if spacing or anchor positions are changed.
Anchors are added to most glyphs automatically with the 
command cmd+U; you only need to refine their position. 
An anchor in the base glyph is connected with the anchor 
in the mark glyph by sharing the same name and additional 
underscore prefix, e.g. a “top” anchor in the base glyph and 
a “_top” anchor in the mark are used to place the mark glyph 
in the compound glyphs.
Select an anchor in the base glyph to get a preview of 
the most common accents that may attach to this glyph. 
Similarly, select an anchor in the mark glyph and this accent 
is shown on all other glyphs that happen to be in the same 
edit view.
Sometimes you need more than one “top” anchor. This is 
the case for Arabic ligatures. In this case, add an underscore 
and a number to the anchor name. Then choose in the 
compound glyph to what anchor the mark component 
should attach. The same applies if there is more than one 
anchor that would fit.
When building letters from several base glyphs, the 
components are set next to each other using the spacing and 
kerning for this combination. For example when building a 
fraction out of one.numr, fraction, two.dnom, the fraction 
will look like the letters have been typed individually.



1. 8.  Background Layer
The background layer is useful for storing a path temporarily. 
To activate the background press Cmd+B. Cmd+K replaces the 
current content of the background with the active selection; 
this works in reverse while the background is active. 
Cmd+Opt+K adds the current selection to the background 
without clearing it first.

1. 9.  Exchanging outlines with Illustrator

1. 9. 1.  Preparation
Find the right scale for the drawing in Illustrator. One point 
unit in Illustrator corresponds to one unit in Glyphs. An 
element that is 1000 pt high will end up at 1000 units height 
in Glyphs.
To get the right scale, first draw a rectangle with the height 
of the capital letters in Glyphs, copy paste it to Illustrator 
and scale the drawings to fit their size to the box.
You also might start with an Illustrator file of 1000 pt height. 
It is important that both ascender and descender are within 
the 1000 points bounds.

1. 9. 2.  Set the Page Origin
If you set the page origin to the intersection of base line and 
LSB, the paths will have the right position.
In Illustrator up to CS4, set the origin of the page with 
dragging the white area in the top left corner between the 
rulers.
In Illustrator up to CS5 set the origin of the page in the 
Artboard Options.

1. 9. 3.  Copy the Paths.
Copy paste the outlines.
There might be a dialog. This should prevent you from 
copying something far outside the bounds. It will move the 
path next to the origin of the glyph.



2.	Font View
2. 1.  Adding Glyphs

There are several ways to add glyphs:
Font > New Glyph (Cmd+Opt+Shift+N) adds an empty glyph.
Font > Duplicate (Cmd+D) duplicates the currently selected 
glyph(s).
Font  > Add Glyphs (Cmd+Shift+G) opens a window where 
you can insert a list of glyph names. As far as information 
about components is available, the glyphs will be built from 
them.

Some entries in the sidebar of the font view have a number 
badge. Right-click it to get a list of all glyphs missing in this 
category.

2. 2.  Filtering and Sorting



Filters help you to get an overview over the glyphs in 
the font. There are predefined letter type and language 
categories. In addition, you can define your own filters, 
e.g. query filters, similar to smart play list in iTunes, or list 
filters.
You can add a Filter with the button in the lower left corner. 
Set up the query with these properties: 
•	 name
•	 script (like Latin or Arabic)
•	 number of paths
•	 compatibility of masters
•	 glyph to be exported
•	 first master made up from components
•	 color label
Select more than one of these filters by holding down the 
Cmd key.

2. 3.  Names and Unicode

2. 3. 1.  Readable or Nice Names
Glyphs contains a glyph info database that holds information 
about, names, Unicode, components , anchor and so on.
Not all glyphs that are defined in the Unicode database 
have official glyph names. For these, one would typically 
use names like “uni042F” or “afii10049”, which are hard to 
memorize. 
It uses the Unicode description and appends a script suffix, 
e.g. “CYRILLIC CAPITAL LETTER A” becomes “A-cy”.
To name ligatures, the names of the components need to be 
joined with an underscore. The script suffix will be appended 
only once (e.g. “lam_alef-ar”). Variation suffixes are only 
added once, as well. They define the role of the whole 
ligature. A ligature formed of “lam-ar.init” and “alef-ar.medi” 
would be called “lam_alef-ar.init”.
If you set the glyph name, all other values will be set 
automatically. If necessary, even the name will be changed. 
Glyphs accepts three different types of input values.
The actual name (“Ia-cy”)
The Unicode value in hex form with a “uni“ prefix 
(“uni042F”) 
The Unicode character as typed from the keyboard (“Я”)



This automatism can be deactivated on a font basis. In this 
case, however, other automatic functions like components 
and feature generation, will not work well.
Window > Glyph Info shows all entries in the internal 
database.



3.	Font Info
3. 1.  Font 

3. 1. 1.  Family name
Family name as it will appear in the InDesign font menu.

3. 1. 2.  Units/em square
Number of units per em square (UPM). 1000 is the default. 
Increasing the upm value improves the representation of 
subtle details. The OpenType allows values up to 16000 but 
values greater than 5000 can lead to problems in InDesign 
and Illustrator. If you need higher precision, it might be 
better to deactivate the grid (see Other settings > Grid).
Click on the double arrow next to the text field to scale the 
entire font.

3. 1. 3.  Other entries
The circular arrow next to the copyright entry updates the 
entry based on designer name and date.

3. 1. 4.  Custom parameters
Use entries to specify more parameters.
When generating the font, Glyphs considers particular 
entries:
postscriptBlueScale
postscriptBlueShift
openTypeOS2WeightClass
openTypeOS2Panose
openTypeOS2UnicodeRanges
openTypeOS2VendorID
trademark
openTypeNameDescription
openTypeNameLicense
openTypeNameLicenseURL
openTypeNameSampleText
openTypeNameWWSFamilyName
openTypeNameWWSSubfamilyName
These names are adopted from the UFO/Robofab 
specifications. See: unifiedfontobject.org



3. 2.  Masters
While information about the designed masters (the input) is 
set under “Masters”, the Instances tab contains information 
about each instance that will be generated when fonts are 
exported (the output).

3. 2. 1.  Proportions – Width and Weight
The values in these two text fields affect only the tool bar 
icons. The values for the actial interpolation are set under 
“Instances”. More information about this in the chapter 
about Multiple Master.

3. 2. 2.  Metric
The vertical metrics have an impact on the line height, and 
serve as a guideline in the editing window.

3. 2. 3.  Stems, Alignment Zones and Hinting
Standard stems and alignment zones are necessary to 
optimize the font’s rendering on screen, where these 
characteristics may be represented by only a few pixels. 
Small deviations in the drawing can - after rounding to the 
pixel grid - result in considerable differences. Stems should 
have a uniform thickness; alignment zones help create an 
even vertical alignment by overshoot suppression.
http://blog.linotype.com/2011/09/die-darstellung-digitaler-
schrift-teil-3-von-5-hinting/?lang=de
http://typophile.com/node/59506

3. 2. 4.  User Parameters
The following values are exported:
postscriptUnderlinePosition
postscriptUnderlineThickness
Both values are interpolated correctly if defined for all 
masters.

3. 3.  Instances
Use the + and – buttons to add and remove instances.

3. 3. 1.  Style name
This is the style name as it will appear in InDesign.



3. 3. 2.  Weight and Width
These settings affect the order of fonts in the font menu. 
Sorting occurs first by width, then by weight, e.g.:
•	 Light Condensed
•	 Condensed
•	 Bold Condensed
•	 Light
•	 Regular
•	 Bold
•	 Light Extended
•	 Extended
•	 Bold Extended

3. 3. 3.  Style Linking
MS Windows applications support only the “basic 4” styles 
per font family, i.e. “Regular”, “Italic”, “Bold” and “Bold Italic”. 
They are accessed via the “B” and “I” buttons in the toolbar.
If a font family is not style linked at all then each style 
appears individually in the font menu. In that case, clicking 
the “B” or “I” buttons creates a synthetic Bold or Italic. Based 
on these conditions, the following strategy is recommended:
• Italic styles should always be linked to their upright counterparts, 
i.e. share the same family name.
• The Bold style should always be linked to the Regular.
• Larger font families require a carefully devised linking strategy.
Linking the SemiBold to the Light is sometimes practiced. If 
you choose to do so, only the Light will appear in the font 
menu and many users are unaware that they can access the 
SemiBold style by selecting Light + “B”.
However, if you want to link SemiBold to Light, enter the 
name of your Light style in the “Linked style” text field of 
your SemiBold instance settings and check “is Bold”.

3. 3. 4.  Interpolation
The Weight and Width settings apply to the “design space” 
spanned between the Masters. For further details see chapter 
on Multiple Masters [was?].

3. 3. 5.  Custom Parameters
The following values are being considered during export.

•	 TypoAscender
•	 TypoDescender
•	 TypoLineGap



•	 winAscent
•	 winDescent
•	 openTypeNameLicense (is given precedence to the same 

option in Font-Info)
•	 openTypeNameLicenseURL (is given precedence to the same 

option in Font-Info)
•	 openTypeOS2WeightClass (overwrites all above weight 

settings)
•	 openTypeOS2WidthClass (overwrites all above width settings)

There are some special settings.
•	 Scale to UPM 
•	 Scales the font immediately after interpolation to avoid 

unnecessary rounding errors
Filter
You can apply a filter after the glyphs are interpolated and 
the overlap is removed. So far only the “Round Corners” 
filter is supported. Add “Filter” on the left column and 
“GyphsFilterRoundCorner; Radius; Visuell Corection”, e.g. 
“GlyphsFilterRoundCorner; 30; 1”

3. 4.  Features
Find on the left all information about font classes and 
features. Put all information that needs to stand outside a 
feature in the prefix.
Glyphs automatically generates most of the common 
features, click the circular arrow in the corner to initiate 
that. The feature generator is based on certain name 
conventions and suffixes. E.g. all letters with names 
ending on “.sc” are being located in the small caps feature. 
Letters described with more than one letter name joined 
by underscores are being recognized as ligatures. Find a 
complete list of the suffixes in the appendix.
To write features manually remove the “Automatic” check or 
create a new feature by clicking the bottom far left button. 
Edit the name of the feature (or class) directly in the list.
Glyphs uses Adobe FDK syntax. Find details at http://www.
adobe.com/devnet/opentype/afdko/topic_feature_file_
syntax.html



3. 5.  Other settings

3. 5. 1.  Grids
The grid width defines how coordinates get rounded. 
Standard is the value 1. Set to 0 rounding doesn’t happen. 
Higher values are helpful when creating a pixel font.

3. 5. 2.  Don’t use nice Names
This option prevents the automatic replacement of glyph 
names. This might be of importance where special workflow 
requirements apply. The option is set in all fonts imported 
from .OTF-files and .UFOs that are opened with Glyphs for 
the first time. Deactivating this option does not immediately 
activate the automatic replacement of names. To activate the 
automatic replacement click Font > Update Glyph Info. This 
might also invalidate the feature code.



4.	Kerning and Spacing
4. 1.  Spacing and Kerning

Spacing is the process of adjusting the side bearings to get 
an even rhythm of the text. There are no “rules” for that. 
However, the same shapes should have the same side 
bearing. An “H” sits in the middle, a “D” has the same LSB as 
the “H” but the RSB is more like the “O”.
There are keyboard shortcuts to change the spacing. Hold 
down the Ctrl key and use the left and right Arrow keys to 
change the LSB, Cmd+arrow keys changes the RSB. The Shift 
key increases the change to 10 units.
Most glyphs fit well next to each other but some need 
specific adjustment, e.g. “T” in combination with “o”.  To 
define these kerning pairs, switch to the Text Tool, type both 
glyphs in the edit view and place the cursor between them. 
The bottom left field (labeled “K:”)  in the info box will show 
the kerning value for this combination. Just set a value 
there.
Or use the keyboard shortcuts for much greater convenience. 
Similar to the metrics keys, Ctrl+Opt+(Shift)+Arrow keys 
changes the kerning to the letter on the left side, while 
Cmd+Opt+(Shift)+Arrow keys change the kerning to the 
letter on the right. The selected letter (with its name in the 
info box) is part of two kerning pairs. Set the kerning for 
both sides with the respective key combinations without 
moving the cursor.
The predefined sample texts cover the most important 
combinations in Latin fonts. Select “Font > Select Sample 
Text…” and choose one line. Use the Arrow keys to move the 
cursor and the Enter key to close the dialog.  
You can define you own texts in the preferences.

4. 2.  Kerning classes
Many glyphs look similar and need the same kerning values. 
Kerning classes capture these similarities and help you 
reduce the number of pairs that need to be set manually.
Kerning then applies not to glyphs but to classes, in the 
sense of kerning all glyphs that look like an “A” or like a “T” 
etc.
In Glyphs, kerning classes are not edited as glyph lists. 
Instead, the class membership is defined as a glyph property. 



For example, put “O” in the left kerning group field for all 
glyphs that look like an “O” on the left (like “C”, “Ccedilla”, 
“G”, “Odieresis” and “O” itself ).
Add a value to each glyph, even if it remains the only glyph 
in its group.
Switch to list mode to have a better overview.

4. 3.  Metrics links
Metrics links work in a very similar way as kerning classes: 
Put in the name of the glyph you want to link to in the side 
bearing field and it will adopt the respective side bearing. 
Note that this is not updated automatically. You need to 
select the glyphs that need updates and select Layer > Update 
Metrics. Or update by clicking in one of the metric fields in 
the info box and then clicking somewhere else.



5.	Multiple Master
5. 1.  Overview

With Multiple Masters you only draw the extreme styles of a 
font family and then interpolate the styles in between. 
It is not advisable to store all single styles of one family in 
one file, especially not upright and italic styles.
In Glyphs you can interpolate between up to five masters. 
They can be arranged like this:

Light BlackSemibold

SemiboldLight Black

Light Condensed Bold Condensed

Light Black

Light Condensed Bold Condensed

Light BoldBold

Condensed

Light

The relations of the masters are defined by “coordinates”, i.e. 
the width and weight properties. In addition, you can define 
other dimensions. The masters span a design space in which 
the instances can be placed.
The nodes of the outlines are not automatically linked 
between the masters. You can insert nodes in one master 
while all other masers stay untouched. Note that for the 
final interpolation, the masters need to be compatible, 
though.



5. 2.  Set-up

Defining the coordinates of the masters sets up the design 
space. For the weight coordinate, it is recommended to use 
the stem width of a representative character such as the 
“n”. This makes it easier to define the stem widths of the 
instances. The weight coordinate is entered in the text field. 
Use the pop up list to set the name of the master and the 
icon in the toolbar. This setting is not used for the style of 
the exported font; it is a rough guideline that allows for 
convenient buttons. The styles of the final fonts are defined 
in the instances.

5. 3.  Merging two files
You can merge two or more open files into one Multiple 
Master File. 
To do so, activate the lighter font, go to Font Info > Masters 
and click “Add” in the bottom left corner. Select the other 
font in the upcoming dialog and click “Okay”. Repeat this for 
all files you want to add, then set weight and width for all 
masters. 



5. 4.  Fix compatibility
When merging masters, Glyphs does not automatically 
fix incompatible outlines. If necessary, this can be done 
manually. Letters with incompatible outlines are marked 
with a red triangle in the font view.
During editing, it is possible to work with incompatible 
paths but for interpolation, they need to be compatible. 
Specifically, this means that the order of the paths as well as 
number and structure of nodes must correspond.
The measuring tool gives the following information: The 
red lines connect the corresponding nodes in all masters. 
If the picture looks as wild as here then something is 
fundamentally wrong.

The two slightly bigger red numbers number the starting 
points of all paths and there is a strait red line that connects 
the starting points of all masters. When comparing outlines, 
you always start at the start node of the paths and follow 
them in the direction that is indecated by the small tirangle 
at the first node.
The colored segments indecate the compatibility of the 
segments. Red means that there is a line in one master 
and a curve in the other. This will not interpolate at all. 
Yellow measn that the paths are from the same type but 
have a different angle. this will interpolate but will have a 
unexpexted result. Green segments are fully compatible.



Exampe:

     

In the foreground you see colored light master and in 
background the bold masters’ paths. The forground have an 
overlat, other than in the background. Remove overlaps to 
get the second picture.
The outlines seem to fit now. The red lines connecting the 
starting points in all masters are running across the letter. 
The starting nodes have to be at the same position. Either 



correct that manually by right clicking the node and choose 
“Make node first” or use the command “Layer > Correct Path 
Direction” on all masters.
In Image 3, the start points are at the same position in both 
masters and all outlines are green.
Tip: Switch between masters with Cmd+1, Cmd+2 etc.

5. 5.  Layers Panel
The Layers Panel shows all layers of the selected glyph. The 
master layers are shown on top. You can copy them to save a 
working state. Select the layer in the list and click the “Copy” 
button. When clicking an entry in the list, the selected layer 
is activated in the current glyph only. This is helpful to 
simultaneously see different layers of one glyph.
To change view between layers use the tool bar buttons. Also 
there is the shortcut Cmd+1, Cmd+2 .., that is Cmd and the 
number of the respective master.



6.	Import and Export
6. 1.  From FontLab

If you have the UFO tools installed, the easiest way is to 
export the font as .ufo files. And open that in Glyphs.
FontLab uses a non-standard format for storing kerning and 
kerning classes. Glyphs detects this and converts it to its 
own system. To do so, it only works if you have a common 
prefix for left and right kerning classes like “_l” for left side 
and “_r” for right side. You have to tell Glyph about that in 
the preferences.
There is also a script available to export .glyphs files directly 
from within FontLab. You can download it from github.com/
schriftgestalt/Glyphs-Scripts/blob/master/Glyphs Export.py
To install, copy it to this folder: /Users/[your user name]/
Library/Application Support/FontLab/Studio 5/Macros/
Glyphs Export.py
After restarting FontLab, it will become available in the 
macro toolbar.

6. 2.  To FontLab
FontLabs data structure is very different from the official 
UFO specification and Glyphs files. To export a file from 
Glyphs to FontLab, generate an instance and choose Export 
> ufo. Select the “Save for use in FontLab”. The .ufo does not 
store any information if a kerning class is for the left or 
right side so we need to add a suffix the class names. You can 
define the suffixes in the preferences. 
In FontLab, you need to go to the classes panel and set the 
checkboxes for left or right side.

6. 3.  Robofab tools
Glyphs can read and write .ufo files. Unfortunately, .ufo files 
cannot contain more than one master. File -> Export allows 
exporting a Multiple Master Glyphs font as several .ufo files.



7.	Appendix
7. 1.  Feature-Suffixes 

liga Ligature Join the glyph names of the components 
with a „_“. The common ligature with „f“, 
„i“ and „l“ are placed in the liga feature, 
all other got to dlig.

dlig Discretionary 
Ligatures

Join the glyph names of the components 
with a „_“. The common ligature with „f“, 
„i“ and „l“ are placed in the liga feature, 
all other got to dlig.

smcp Small Capitals Add „.sc“ suffix to the glyph name.

sups Superscript Add „.sups“ or „superior“ suffix to the 
glyph name.

subs Subscript Add „.subs“ suffix to the glyph name.

sinf Scientific Inferiors Add „.sinf“ or „.subs“ suffix to the glyph 
name.

dnom Denominators Add „.dnom“ suffix to the glyph name.

numr Numerators Add „.numr“ suffix to the glyph name.

onum Oldstyle Figures Add „.osf“ (for proportional oldstyle 
figures) or „.tosf“ (for tabular oldstyle 
figures) to the glyph name.

tnum Tabular Figures Add „.tf“ (for tabular figures) or „.tosf“ 
(for tabular oldstyle figures) to the glyph 
name.

pnum Proportional 
Figures

Add „.osf“ (for proportional oldstyle 
figures) or „.lf“ (for proportional lining 
figures) to the glyph name.

lnum Lining Figures Add „.lf“ (for proportional lining figures) 
or „.tf“ (for tabular figures) to the glyph 
name.

hist Historical Forms Add „.hist“ suffix to the glyph name.

frac Fractions The frac feature is generated from a 
build in list of glyphs.

locl Localized Forms Add a “.locl”+the three letter Language 
Code to the glyph there. And there is a 
build in list of glyphs, that are added to 
the feature. 



ssXX Stylistic Set XX Add „.ssXX“ suffix to the glyph name, for 
example „.ss01“ or „.xx12“.
Add “Name:“ plus the Features 
descriptive name to the font note. This 
will generate the feature name entries 
for stylistic set names. Or add the hole 
featureNames definition to the note


